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LAÄP TRÌNH WINCC CHO 
HEÄ THOÁNG SCADA
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Heä thoáng giaùm saùt vaø thu thaäp döõ lieäu SCADA ñieån hình
Supervisory Control and Data Aquisition System
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Giaûi phaùp truyeàn thoâng cuûa Siemens: Simatic-net
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Moät soá chöùc naêng cô baûn cuûa heä thoáng SCADA
+ Ñieàu khieån (Control)
+ Hieån thò (Display): Trend (Historical), Table...
+ Caûnh baùo (Alarm)
+ Löu tröõ (Archieve)
+ In aán (Report)

Moät soá phaàn meàm cho heä SCADA hieän coù taïi Vieät Nam
WinCC (Siemens), Fix-Intellution, Wonderware, Scitect, 

Plantscape (Honeywell)...

Ñeå trao ñoåi döõ lieäu vôùi PLC caùc phaàn meàm naøy ñeàu söû duïng 
khaùi nieäm Tag hay Point



148Bis Nam Kyø Khôûi Nghóa, Q. 1Provina technology ltd. Hoà Chí Minh City 

WINCC 
WINDOWS CONTROL CENTER
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Caøi ñaët WinCC
Caáu hình maùy tính:

Heä ñieàu haønh söû duïng cho WinCC5.0: Win2000 Service Pack 
2, WinNT Service Pack 5 
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Ñöa ñóa CD vaøo
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Choïn Next vaø laøm theo höôùng daãn treân maøn hình
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Laøm theo chæ daãn treân maøn hình cho ñeán khi hoaøn taát
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Caùc böôùc ñeå taïo moät Project trong WinCC
1. Khôûi ñoäng WinCC
2. Taïo moät Project môùi
3. Caøi ñaët Driver keát noái PLC
4. Ñònh nghóa caùc Tag söû duïng
5. Taïo vaø soaïn thaûo moät giao dieän ngöôøi duøng
6. Caøi ñaët thoâng soá cho winCC Runtime
7. Chaïy chöông trình (Activate)
8. Coù theå duøng chöông trình WinCC Variable Simulator ñeå

moâ phoûng hoaït ñoäng cuûa caùc Tag
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Trình töï taïo moät Project

1. Khôûi ñoäng WinCC:
Nhaán nuùt Start→Simatic→WinCC→Windows Control Center
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2.Taïo moät Project

Choïn Single-User Project Goõ teân Project vaøo project name 
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3. Caøi ñaët Driver keát noáiPLC
Click chuoät phaûi vaøo Tag Management → Add new Driver
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Choïn Driver ñeå keát noái PLC töø hoäp thoaïi sau:

Keát noái vôùi 
PLC S7-
300 choïn 
Driver naøy
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+ Caàn phaân bieät hai loaïi Internal Tag vaø External (Process) Tag
Taïo External Tag
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Goõ teân vaø nhaáp OK töø hoäp thoaïi New Connection Properties
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Choïn New Tag töø Connection vöøa taïo 
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Goõ teân Tag vaø choïn kieåu döõ lieäu cuûa Tag
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Click chuoät vaøo nuùt Select ñeå gaùn ñòa chæ cho Tag

Choïn OK ñeå löu 
ñòa chæ cho Tag
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Coù theå choïn oâ Limit Scaling ñeå taïo Scale(Tyû leä) cho Tag Analog
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Click chuoät phaûi vaøo Internal Tag vaø choïn New Tag ñeå taïo 
Internal Tag
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Goõ teân vaø choïn kieåu döõ lieäu cho Internal Tag
Choïn OK ñeå löu 
Internal Tag
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Thöïc haønh: Taïo Internal tag coù teân laø tank level, kieåu döõ lieäu laø
Unsigned 16 bits
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4.Taïo giao dieän
Click chuoät phaûi vaøo Graphics Designer → Choïn New
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Coù theå ñoåi teân Picture baèng caùch nhaáp chuoät phaûi, choïn Rename

Thöïc haønh: Taïo hai trang maøn hình coù teân laø Start.pdl 
vaø Sample.pdl 
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Caùc coâng cuï treân Graphics Designer
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Treân trang maøn hình teân Start.pdl ,taïo giao dieän sau:
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Ñeå laáy caùc hình aûnh coù saün vaøo menu View, choïn Library

Choïn hai nuùt 
naøy ñeå xem 
caùc hình maãu
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Taïo nuùt nhaán
Choïn Button trong muïc Windows Object beân Object Palette, keùo 
qua vaø ñaët taïi vò trí mong muoán treân maøn hình soaïn thaûo 
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Goõ vaøo muïc Text vaø choïn trang maøn hình muoán chæ tôùi

Thöïc hieän moät 
nuùt nhaán 
töông töï nhö
treân trang 
maøn hình 
Sample.pdl
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Taïo hình aûnh ñoäng cho ñoái töôïng
Nhaáp chuoät phaûi vaøo ñoái töôïng, choïn Properties
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Choïn Tag Assignment treân tab Properties
Nhaáp chuoät phaûi vaøo muïc Dynamic → Choïn Tag muoán lieân keát 
cho ñoái töôïng
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Nhaáp chuoät phaûi vaøo muïc Current choïn Upon Change
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Taïo I/O Field ñeå quan saùt hay caøi ñaët döõ lieäu cho ñoái töôïng
Keùo I/O Field coù trong muïc Smart Object beân cuûa soå Object 
Palette vaøo maøn hình soaïn thaûo.

+ Choïn Tag vaø thôøi gian caäp 
nhaät töø cuûa soå I/O Field.

+ Choïn Save ñeå löu laïi trang 
maøn hình tröôùc khi chaïy 
Runtime
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5. Caøi ñaët tham soá khi chaïy Runtime
Treân cöûa soå WinCC Explorer click chuoät phaûi vaøo muïc 
Computer, choïn Properies → Choïn Properties laàn nöõa.
Treân tab Graphics Runtime choïn trang maøn hình khôûi 
ñoäng, vaø ñaët caùc thuoäc tính cho maøn hình giao dieän

Nhaáp OK ñeå thoaùt
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Nhaán nuùt Activate      ñeå chaïy chöông trình
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Söû duïng chöông trình moâ phoûng caùc Tag trong WinCC

+ Töø maøn hình windows, vaøo Start→ Choïn Simatic →WinCC 
→Tool →WinCC Variable Simulator.

+ Treân muïc Properties, choïn New Tag töø menu Edit → Choïn Tag 
caàn moâ phoûng vaø caùch thöùc thay ñoåi döõ lieäu cuûa Tag: Daïng Sin, 
Taêng daàn ,giaûm daàn, dao ñoäng.. → Choïn active.

+ Trôû laïi muïc List of Tags choïn Start Simulation ñeå baét ñaàu moâ 
phoûng.
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Hieån thò thoâng soá cuûa quaù
trình saûn xuaát
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Söû duïng Tag logging ñeå hieån thò thoâng soá cuûa quaù trình 
saûn xuaát qua caùc böôùc sau:

1. Môû Tag Logging Editor

2. Ñaët caáu hình cho Timer

3. Taïo döõ lieäu löu tröõ vôùi Archieve Wizard

4. Veõ ñoà thò hieån thò thoâng soá cuûa quaù trình saûn xuaát

5. Taïo moät baûng baùo caùo 

6. Caøi ñaët tham soá Runtime

7. Chaïy chöông trình
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1. Môû Tag Logging Editor
Nhaán chuoät phaûi vaøo Tag Logging treân cöûa soå WinCC Explorer→Open
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2. Ñaët caáu hình cho Timer
Nhaán chuoät phaûi vaøo timer, choïn New vaø caøi ñaët thôøi gian laáy döõ 
lieäu
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3. Taïo döõ lieäu löu tröõ vôùi Archive Wizard
Nhaáp chuoät phaûi vaøo Archieve , choïn Archieve Wizard, nhaán 
Next vaø thöïc hieän nhö caùc böôùc döôùi ñaây:
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Nhaán Select ñeå choïn Tag caàn löu tröõ 

Nhaán nuùt Save 
tröôùc khi ñoùng 
cuûa soå Archieve
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4. Veõ ñoà thò hieån thò thoâng soá cuûa quaù trình saûn xuaát

+ Coù theå taïo moät trang maøn hình môùi.

+ Trong cuûa soå Graphics Designer, choïn WinCC Online 
Trend Control treân Tab Control beân cuûa soå Object 
Palette vaø keùo vaøo maøn hình soaïn thaûo. 

+ Coù theå goõ teân ñoà thò vaø caøi ñaët caùc thoäc tính cho ñoà
thò töø cöûa soå sau:
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Chuyeån sang Tab Curve ñeå choïn teân Tag maø caàn veõ ñoà thò nhö
sau  

Nhaán OK ñeå löu 
laïi caøi ñaët naøy vaø
thoaùt
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Nhaán CTrl + Double Click ñeå xem thöû hình aûnh cuûa ñoà thò luùc 
chaïy Runtime, coù theå söûa laïi caùc thoâng soá cuûa ñoà thò sao cho 
hôïp lyù.
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5. Taïo baûng baùo caùo

+ Choïn WinCC Online 
Table Control coù trong 
Tab “Control” beân cöûa 
soå Object Palette  vaø
ñaët vaøo trang maøn 
hình soaïn thaûo.

+ Ñieàn teân vaø caùc 
thoâng soá cuûa baûng töø
cöûa soå hieän ra. 
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Chuyeån qua tab “Column” ñeå goõ teân cuûa giaù trò hieån thò treân baûng 
vaø choïn Tag caàn quan saùt nhö hình sau:
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Coù theå nhaán Ctrl+ Double Click ñeå quan saùt tröôùc baûng thoâng soá
luùc chaïy Runtime
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6. Caøi ñaët tham soá khi chaïy Runtime
+  Treân cöûa soå WinCC Explorer click chuoät phaûi vaøo muïc 
Computer, choïn Properies → Choïn Properties laàn nöõa.

+  Treân tab “Start up”, choïn tag Logging Runtime
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+ Nhaán nuùt Activate      
ñeå chaïy chöông trình. 

+ Coù theå kích hoaït 
chöông trình moâ phoûng 
ñeå xem hình aûnh cuûa ñoà
thò vaø baûng thoâng soá khi 
chaïy Runtime
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Thieát laäp caùc caûnh baùo vaø thoâng baùo loãi
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Söû duïng Alarm Logging ñeå thieát laäp caùc caûnh baùo vaø thoâng baùo loãi.

Caùc trình töï coù theå thöïc hieän nhö sau (tuyø theo yeâu caàu) :

1. Môû cöûa soå soaïn thaûo Alarm Logging Editor
2. Khôûi ñoäng System Wizard
3. Caøi ñaët Message Text
4. Duøng Message Class ñeå ñaët maøu cho caùc message
5. Caøi ñaët Limit value
6. Taïo Message Window treân maøn hình soaïn thaûo
7. Thieát laäp caùc tham soá Runtime
8. Chaïy chöông trình
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1. Môû cöûa soå Alarm Logging
Nhaán chuoät phaûi vaøo Alarm Logging, choïn Open
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2. Khôûi ñoäng System Wizard
Vaøo File → Select Wizard →choïn System Wizard→Next. 
Choïn caùc thoâng soá nhö nhöõng hình sau ñaây:

Nhaán Next
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Nhaán Next
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Nhaán Next. 
Treân baûng toùm 
taét nhaán Apply
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3. Caøi ñaët Message 
Text
+ Nhaán chuoät phaûi vaøo 
daáu + ôû muïc Message 
Blocks, choïn User Text 
Blocks. 

+ Tieáp theo nhaán chuoät 
phaûi vaøo Message Text 
beân cöûa soå Data 
Window ,choïn 
Properties vaø goõ vaøo 
chieàu daøi cuûa Message 
Text
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Thöïc hieän töông töï vôùi Point of Error
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Caøi ñaët cho caùc 
Message töø caùc 
haøng naøy
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Double Click chuoät vaøo :
°Caùc haøng choïn Append New Line ñeå taïo moät haøng thoâng baùo môùi.
°Message Tag ñeå choïn Tag baùo loãi.
°Message Bit ñeå choïn Bit loãi trong coù trong Message Tag.
°Message Text ñeå ñieàn caâu thoâng baùo loãi
°Point of error ñeå chæ vò trí bò loãi trong heä thoáng saûn xuaát.
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4. Caøi ñaët maøu cho 
caùc Message
° Click chuoät vaøo daáu 
+ ôû muïc Message Class 
trong cuûa soå Alarm 
Logging. 
° Click vaøo Error vaø
Click phaûi chuoät vaøo 
Alarm, choïn Properties.

°Choïn maøu Text vaø
maøu neàn cho caùc thoâng 
baùo loãi: Came in, Went 
out, Acknowlege.
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5.Caøi ñaët Limit Value

+ Treân cöûa soå Alarm 
Logging Editor choïn menu 
Tools → Add-Ins.

+ Treân cöûa soå Add-Ins 
choïn Analog Alarm
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Nhaáp phaûi chuoät vaøo 
Analog alarm, choïn New
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Treân cuûa soå
Properties, choïn Tag 
muoán quan saùt hai 

giaù trò möùc Lower vaø
Upper Value
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Coù theå choïn Tag coù saün hoaëc taïo môùi Tag töø cöûa soå hieän ra

+ ÔÛ ñaây coù theå taïo 
moät tag môùi coù teân 
laø AnalogAlarm, 
kieåu Unsigned 
16bits 

+ Nhaán OK ñeå xaùc 
nhaän caøi ñaët vaø
thoaùt 
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Caøi ñaët Limit Value
Nhaáp phaûi chuoät vaøo Tag môùi vöøa khai baùo, choïn New
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Treân cöûa soå Properties hieän ra, choïn caùc giaù trò cho Upper vaø
Lower Limit

Nhaán OK ñeå
xaùc nhaän 
caøi ñaët vaø
thoaùt
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Choïn Save ñeå thoaùt khoûi Alarm Logging Editor



148Bis Nam Kyø Khôûi Nghóa, Q. 1Provina technology ltd. Hoà Chí Minh City 

6. Taïo Message window treân maøn hình soaïn thaûo
Choïn WinCC Alarm Control treân tab “ Control” beân cuûa soå Object 
Palette vaø ñaët vaøo maøn hình soaïn thaûo.
Goõ Teân cöûa soå vaø choïn vaøo oâ Display

Nhaán nuùt OK 
ñeå thoaùt
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7. Thieát laäp tham soá Runtime

+ Treân cöûa soå WinCC Explorer click chuoät phaûi vaøo muïc 
Computer, choïn Properies → Choïn Properties laàn nöõa.

+ Treân tab “Start up”, choïn tag Alarm Logging Runtime vaø
Text Library Runtime.

Nhaán OK ñeå thoaùt
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8. Chaïy chöông trình
Nhaán nuùt Activate      ñeå chaïy chöông trình. Coù theå kích hoaït 
chöông trình moâ phoûng ñeå xem caùc thoâng baùo loãi khi chaïy 
Runtime
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LAÄP TRÌNH C CHO WINCC
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TAÏO FUNCTION VAØ ACTION 
TRONG WINCC
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Function: Söû duïng haøm khi caàn tính toaùn nhieàu laàn trong 
chöông trình. Lôïi ích laø: 
+ Chæ caàn laäp trình moät laàn. Khi caàn thöïc thi thì chæ vieäc goïi 
haøm vaø ñöa vaøo caùc ñoái soá thích hôïp.
+ Chöông trình ngaén vaø deã hieåu.

Action: Khaùc vôùi Function, action chæ hoaït ñoäng khi coù ñieàu kieän 
kích (Function khoâng töï hoaït ñoäng khi chaïy Runtime).
+ Action khoâng coù ñoái soá.
+ Coù theå taïo baûn quyeàn cho Action

Ñeå taïo vaø soaïn thaûo Function hay Action duøng Global Script cuûa 
WinCC
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GLOBAL SCRIPT
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Cöûa soå soaïn thaûo cuûa Global Script:

Navigation 
Window

Editing Window

Output 
Window
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Navigation Windows: Cöûa soå ñeå löïa choïn Function hay Action 
ñeå soaïn thaûo.

Editing Windows: Cöûa soå soaïn thaûo chöông trình.

Output Windows: Cöûa soå hieån thò keát cuûa bieân dòch cuûa haøm vaø
Action hoaëc Search Files
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Khaû naêng laäp trình vaø öùng duïng:

Action: Ñöôïc taïo môùi hay söûa ñoåi trong Global Script. Chæ duøng 
ñöôïc trong Project maø noù ñöôïc taïo ra.

Project Function: Chæ ñöôïc duøng trong Project hieän taïi. Coù theå taïo 
môùi hay söûa nhöõng haøm coù saün.

Standard Function: Duøng ñöôïc trong taát caû Project. Coù theå taïo 
môùi hay söûa nhöõng haøm coù saün
.
Internal Function: Duøng ñöôïc trong taát caû Project. Khoâng theå taïo 
môùi hay söûa nhöõng haøm coù saün.
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Laäp trình taïo Action
Töø maøn hình Graphics Designer, click phaûi vaøo ñoái töôïng 

(object) caàn thieát laäp Action, choïn Properties.
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Click phaûi vaøo muïc Dynamics hay Action cuûa Properties hay 
Events vaø choïn C-Action töø menu hieän ra
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Cöûa soå Global Script Bieân dòch Taïo Trigger
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+ Laäp trình C-Action cho Properties cuûa ñoái töôïng thì caàn 
phaûi coù Trigger, coøn Events thì khoâng(vì baûn thaân event laø
trigger roài).

+ Sau khi laäp trình cho Action xong thì bieân dòch baèng nuùt . 
Neáu coù loãi hieån thò trong Output Window thì Double click vaøo 
ngay loãi ñeå bieát vò trí loãi trong chöông trình vaø söûa loãi, neáu 
khoâng coù loãi thì choïn OK ñeå thoaùt.
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Caáu truùc chöông trình cuûa moät C-Action cho moät Property 
cuûa ñoái töôïng:

Caâu leänh # include”apdefap.h” laø khai baùo thö vieän caùc Function 
vaø Action maø WinCC hoã trôï saün.
Header(maøu xaùm): Ñaây laø doøng maõ leänh töï ñoäng phaùt sinh gioáng 
nhau cho caùc Properties vaø khoâng ñöôïc thay ñoåi. Bao goàm :
+ Picture Name (lpszPictureName)
+ Object Name (lpszObjectName)
+ Property Name (lpszPropertyName)
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(1)   Khai baùo bieán
(2)   Tính toaùn caùc giaù trò cho Property
(3)   Traû veà giaù trò cho Property.

Sau khi laäp trình xong Action cho moät Property cuûa ñoái 
töôïng thì phaûi choïn Trigger cho noù

Caáu truùc chöông trình cuûa moät C-Action cho moät Event cuûa ñoái töôïng:
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Baøi taäp thöïc haønh: 

Vieát chöông trình tính toång hai soá integer vaø xuaátkeát quaû
tính ñöôïc ra cöûa soå GSC Diagnostics khi nhaán moät Button
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(1) Khai baùo bieán
(2) Laäp trình xöû lyù söï kieän. 

Laäp trình taïo moät Function
+  Project Function, Standard Function vaø Internal Function ñeàu coù
theå laäp trình trong Global Script.

+ Click chuoät phaûivaøo loaïi Function muoán taïo,choïn New 

Header(maøu xaùm): Ñaây laø doøng maõ leänh töï ñoäng phaùt 
sinh vaø khoâng ñöôïc thay ñoåi. Header coù theå khaùc nhau cho 
caùc events khaùc nhau.
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Caáu truùc cuûa moät Function ñôn giaûn:

Khai baùo

+ Kieåu döõ lieäu traû veà cuûa haøm

+ Teân haøm

+ Ñoái soá cuøng vôùi kieåu döõ lieäu cuûa noù

+ Thaân haøm

+ Giaù trò traû veà cuûa haøm.
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+ Ñeå xem keát quûa tính toaùn cuûa haøm vaø chaån ñoaùn loãi ta 
duøng cöûa soå Global Script Diagnostics Window, caùch thöïc hieän 
nhö sau:
° Môû moät trang maøn hình trong Graphics Designer.
° Choïn Application Window coù trong Smart Object beân Object 
Palete vaø keùo vaøo trang maøn hình ñang thieát keá vaø thaû chuoät ra
° Choïn Global Sript töø Window Contents hieän ra→ Choïn GSC 
Diagnostic→OK.
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Click phaûi vaøo Application Window vöøa taïo choïn 
Property → Choïn Yes cho taát caû caùc thuoäc tính cuûa 

Miscellaneous
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+ Khi chaïy Runtime keát quûa cuûa leänh printf seõ ñöôïc 
hieän ra treân cöûa soå naøy. 

+ Coù theå duøng nuùt nhaán ñeå döøng vieäc caäp nhaät giaù
trò ñeå in aán hoaëc löu tröõ caùc keát quûa.
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Trình töï taïo moät Project Function
1. Môû cöûa soå Global Script
2. Nhaáp phaûi chuoät vaøo Project Functions vaø choïn New
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3. Vieát chöông trình cho haøm beân cuûa soå Editor, bao goàm:
Kieåu döõ lieäu traû veà cuûa haøm, teân haøm, khai baùo caùc ñoái soá, thaân 
haøm, giaù trò traû veà cho haøm. 

Löu yù laø sau moãi doøng leänh laø daáu “;”
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4. Bieân dòch cho haøm.
5. Coù theå taïo Password ñeå giöõ baûo maät cho haømbaèng caùch nhaán nuùt
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Caùc thuû tuïc hay söû duïng khi laäp trình
Ñònh nghóa Tag:
Cuù phaùp: # define Teân Tag khi laäp trình” Teân Tag ñaõ khai baùo 

trong Tag Manager” . 
Ví duï:
Giaû söû ta ñaõ ñònh nghóa moät Tag teân laø Start trong Tag Manager coù

ñòa chæ treân PLC ñaõ xaùc ñònh töø tröôùc. Söû duïng caâu leänh:
# define Tag0”Start”

thì khi ñoù trong chöông trình ta duøng bieán Tag0 thay cho Tag 
“Start” ñaõ khai baùo trong Tag Management
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Khai baùo haèng, bieán

Khai baùo haèng:
Cuù phaùp: # define Teân haèng_Giaù trò cuûa haèng
Ví duï: #define Max 365;

Khai baùo bieán:
Cuù phaùp: Kieåu döõ lieäu cuûa bieán_Teân bieán
(Coù theå gaùn giaù trò ban ñaàu cho bieán khi khai baùo)
Ví duï: int a;

int b=0;
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Caùc kieåu döõ lieäu cuûa bieán vaø taàm söû duïng:
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Thuû tuïc xuaát döõ lieäu ra maøn hình:

printf ();

Ví duï:

tuoi=10;

printf(“I am %d years old\r\n”,tuoi);

%d,\r,\n: laø caùc ñònh daïng khi xuaát döõ lieäu ra maøn hình
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Ñònh daïng döõ lieäu khi xuaát ra maøn hình
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Moät soá haøm hay söû duïng trong chöông trình
1. SetTagBit

Cuù phaùp:
Noäi dung: Ñònh giaù trò cho moät Tag coù kieåu döõ lieäu laø Binary

2. SetTagByte
Cuù phaùp:
Noäi dung: Ñònh giaù trò cho moät Tag coù kieåu döõ lieäu laø 8bit  

khoâng daáu
3. SetTagSByte  Cuù phaùp: 

Noäi dung: Ñònh giaù trò cho moät Tag coù kieåu döõ 
lieäu laø 8bit coù daáu
Töông töï cho caùc haøm SetTagWord, SettagDWord...
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4. GetTagBit

Cuù phaùp: 

Noäi dung: Laáy giaù trò hieän taïi cuûa moät Tag coù kieåu Binary

5. GetTagByte

Cuù phaùp:  

Noäi dung: Laáy giaù trò cuûa moät Tag coù kieåu döõ lieäu laø 8bit  
khoâng daáu

6. GetTagSByte  Cuù phaùp:  

Noäi dung: Laáy giaù trò hieän taïi cuûa moät Tag coù kieåu 
döõ lieäu laø 8bit coù daáu

Töông töï cho caùc haøm GetTagWord, GetTagDWord...
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Caùc haøm ñieàu khieån
1. Thoaùt khoûi Runtime:
Cuù phaùp: 
Noäi dung: Thoaùt khoûi chöông trình WinCC ñang chaïy Runtime

2. Thoaùt khoûi WinCC:
Cuù phaùp: 
Noäi dung: Thoaùt khoûi chöông trình WinCC, keå caû WinCC Explorer
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Caùc haøm xöû lyù tính toaùn
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Caùc haøm tính toaùn treân Bit
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Caùc toaùn töû Logic
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Caùc 
haøm 
toaùn 
hoïc
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Pointer- Con troû
+ Laø coâng cuï laäp trình thieát yeáu cuûa ngoân ngöõ C
+ Con troû laø moät bieán chöùa moät ñòa chæ, thöôøng laø ñòa chæ
cuûa moät bieán khaùc
Khai baùo bieán kieåu con troû:

Kieåu döõ lieäu* Teân bieán;
Ví duï: int* a;

Thì bieán con troû a seõ troû vaøo moät ñòa chæ coù kieåu döõ 
lieäu laø soá nguyeân. Tuy nhieân vôùi khai baùo naøy thì noäi dung 
con troû chöa ñöôïc xaùc ñònh.
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+  Ñeå söû duïng bieán con troû thì phaûi gaùn ñòa chæ cuûa moät bieán cho 
noù. Ví duï: int a;

int* b;
b= &a; // Bieán con troû b seõ coù noäi dung laø

ñòa chæ cuûa bieán a kieåu int.

+  Ñeå truy xuaát ñeán noäi dung cuûa bieán maø con troû troû tôùi ta duøng 
toaùn töû “ * “ Ví duï: int a,

int b=5;
int* c;
c=&b;
a=*b;

thì keát quaû cuûa bieán a laø 5;
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Baøi taäp:
Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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Vector- Döõ lieäu kieåu maûng
Cuù phaùp:

Kieåu döõ lieäu _Teân bieán[ Soá phaàn töû cuûa bieán];

Ví duï: int a[5]; 
thì bieán a laø moät vector coù 5 phaàn töû kieåu int: 

a[1],a[2],a[3],a[4],a[5] 

+  Muoán truy xuaát töøng phaàn töû cuûa vector ta duøng toaùn töû [ ].
Ví duï b=a[3];...
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Baøi taäp:
Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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Döõ lieäu kieåu String

String coù theå ñöôïc khai baùo theo hai caùch:
+   Laø moät vector caùc kyù töï.

Ví duï:   char st [10]=“Hello”;
+   Hoaëc laø moät con troû troû tôùi moät kyù töï. 

Ví duï:   char* st=“Hello”.
Neáu ñònh nghóa theo kieåu pointer thì khoâng caàn theâm kích 
thöôùc cho chuoãi.
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Nhoùm leänh taïo voøng laëp
1. Leänh While
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Baøi taäp:

Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông 
trình sau laø gì? 



148Bis Nam Kyø Khôûi Nghóa, Q. 1Provina technology ltd. Hoà Chí Minh City 

2. Leänh do -while
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Baøi taäp:

Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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3. Leänh for
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Baøi taäp:

Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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Nhoùm leänh ñieàu khieån chöông trình
1. Leänh if-else

2. Leänh switch-case
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Baøi taäp:

Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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Function vaø caùch truyeàn ñoái soá qua haøm

Ví duï:
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Baøi taäp:

Keát quaû khi nhaán nuùt thöïc hieän  ñoaïn chöông trình 
sau laø gì? 
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Söû duïng DDE Server - Dynamic 
Data Exchange - ñeå lieân keát döõ 

lieäu cuûa WinCC vôùi Excel
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Hai caùch ñeå thieát laäp keát noái DDE
+ Local DDE connection

Chaïy WinCC treân maùy cuïc boä vôùi Single-User System
Hay treân maùy Server vôùi Multi-User System
+ Keát noái DDE thoâng qua maïng

Hai caùch thieát laäp treân caàn phaûi Add theâmChöông 
trình: DDEServer.exe vôùi tham soá “/v /nohold/noconfirm” vaøo 
Srart-up list cuûa Computer ñang chaïy WinCC
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Söû duïng Local DDE connection
+   Chaïy WinCC treân maùy cuïc boä vôùi Single-User System

hay treân maùy Server vôùi Multi-User System
+   Click chuoät phaûi vaøo Computer choïn Properties→ Choïn 

Properties laàn nöõa. Treân Tab Startup, nhaán nuùt Add
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Nhaán Browse beân caïnh oâ Application, choïn File DDEServer.exe 
(thöôøng naèm trong ñöôøng daãn 
Vôùi tham soá
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Ñaùnh daáu vaøo oâ Project Directory ôû muïc Working Directory

Khôûi ñoäng laïi maùy thì chöông trình DDEServer môùi thöïc thi ñöôïc
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+  Sau khi khôûi ñoäng laïi maùy, chuyeån sang chaïy Runtime cho 
WinCC Project. 
+  Choïn Tag muoán löu tröõ döõ lieäu töø cöûa soå WinCC DDE-
Server.
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Thöïc hieän caùc böôùc sau ñeå keát noái vôùi excel
1.  Click chuoât vaøo Tag List ñeå choïn Tag caàn löu tröõ → Choïn OK 
ñeå löu vaøo Clipboard.
2. Môû chöông trình Excel.
3.  Choïn moät cell muoán ghi giaù trò cuûa Tag vaøo.
4.  Goõ daáu “=“ vaøo Excel Formular Bar.
5.  Nhaán Ctrl+V ñeå Paste döõ lieäu töø WinCC ra cell vöøa löïa choïn.
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Baøi taäp thöïc haønh cuoái khoaù

Thieát keá giao dieän WinCC hoaøn chænh ñeå ñieàu khieån vaø

giaùm saùt  heä thoáng FMS-500 cho töøng traïm:

+  Distribution

+  Testing

+  Sorting

+  Handling 


